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Introduction
PC-TimeClock is a package that helps you keep track of how much time you spend working on 

your computer.    This information is useful if you bill clients for time you spend on their behalf.    If you use 
your computer for both business and personal activities, PC-TimeClock can also separate the projects 
into different categories, which allows you to easily determine what percentage of your usage was for 
business purposes.    This greatly simplifies the calculation of the deduction allowed by the IRS for the 
business use of your computer.



Warranty Disclaimer
THIS SOFTWARE IS PROVIDED AS-IS.    THERE ARE NO WARRANTIES, EXPRESSED OR IMPLIED. 
KMR Consulting DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, WHETHER 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND ALL SUCH WARRANTIES
ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED.    NEITHER KMR Consulting, NOR ANYONE 
ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS 
SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH SOFTWARE EVEN IF KMR 
Consulting HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS.    IN NO 
EVENT SHALL KMR Consulting's LIABILITY FOR ANY DAMAGES EVER EXCEED THE PRICE PAID 
FOR THE LICENSE TO USE THE SOFTWARE, REGARDLESS OF THE FORM OF THE CLAIM.    THE 
PERSON OR PERSONS USING THE SOFTWARE BEAR ALL RISK AS TO THE QUALITY AND 
PERFORMANCE OF THE SOFTWARE.    Some states do not allow the exclusion of the limit of liability 
for consequential or incidental damages, so the above limitation may not apply to you.



License to Use PC-TimeClock

Registered Version:
This software and the disk(s) on which it is contained is licensed to you, for your own use.    This 

is copyrighted software.    You are not obtaining title to the software or any copyright rights.    You may not 
sublicense, rent, lease, convey, modify, translate, convert to another programming language, decompile, 
or disassemble the software for any purpose.

You may make as many copies of this software as you need for backup purposes.    You may use 
this software on more than one computer provided there is no chance that it will be used 
simultaneously on more computers than you have purchased registrations for.    If you need to use 
the software on more than one computer simultaneously, you must purchase either a separate 
registration for each computer or a site license.    Discounted fees apply to multiple registrations and site 
licenses; contact KMR Consulting for details.

This agreement shall be governed by the Laws of the State of New York and shall inure to the 
benefit of KMR Consulting, and any successors, administrators, heirs and assigns.    Any action or 
proceeding brought by either party against the other arising out of or related to this agreement shall be 
brought only in a STATE or FEDERAL COURT of competent jurisdiction located in Monroe County, New 
York.    The parties hereby consent to in personam jurisdiction of said courts.

Shareware Version:
You may use the shareware version of this software for up to 60 days without payment of any 

fees.    You may use it on more than one computer simultaneously.    You may give copies of the 
shareware version to others.    After 60 days, you must either register the software or discontinue its use.   
Except for these differences, the license to use the shareware version of the software is identical to the 
license for the registered version.

Note: the shareware version is identical to the registered version except as described in 
Limitations in the Shareware Version section.



The Fine Print
Thank you for your interest in PC-TimeClock.    Please read the warranty disclaimer and license 

statement immediately preceding this section.

The lack of warranty accompanying most software seems distressing at first glance.    Chief 
among the reasons for doing this is the proliferation of different hardware and software environments, and
the existence of computers made by different manufacturers who claim that they are IBM-PC compatible.  
Software authors have no control over the type of hardware and the operating system you have, or other 
programs you may use, nor can we guarantee that you will use this program correctly.    Yet any of these 
things might cause a malfunction.

However, the best part about shareware is that you have the opportunity to actually use the 
program before paying for it.    We also provide one year of free technical support to our registered users, 
so from a practical point of view, there is little for us to warrant, as you already know that the software 
works on your machine.



Association of Shareware Professionals
KMR Consulting is a member of the Association of Shareware Professionals (ASP).    ASP wants 

to make sure that the shareware principle works for you.    If you are unable to resolve a shareware-
related problem with an ASP member by contacting the member directly, ASP may be able to help.    The 
ASP Ombudsman can help you resolve a dispute or problem with an ASP member, but does not provide 
technical support for members' products.    Please write to the ASP Ombudsman at 545 Grover Road, 
Muskegon, MI USA 49442-9427, Fax 616-788-2765, or send a CompuServe message via CompuServe 
Mail to ASP Ombudsman 70007,3536.



Installation

Selecting a Directory
Before installing PC-TimeClock, you should decide what directory you want to put it in.    To avoid 

conflicts with other software, we recommend against installing it in a directory which contains anything 
else; it is better to create a new directory for it.    We suggest the directory c:\timeclk unless you have 
reason to put it somewhere else.

Installing the Shareware Version
Installing the shareware version of PC-TimeClock is easy.    First, unpack the archive file 

containing the distribution (if you're reading this, you have done that already).    You should have the 
following files:

timeclk.exe PC-TimeClock for Windows 3.1
tcreport.exe PC-TimeClock Reporter for Windows 3.1
timclk32.exe PC-TimeClock for Windows 95 and NT
tcrept32.exe PC-TimeClock Reporter for Windows 95 and NT
timeclk.hlp This help file
register.txt Registration form
ctl3dv2.dll Optional file to provide 3-D screens (see below)
timeclk.ini Initialization file used with the tutorial examples

Simply copy these files to the directory you decided upon earlier.    If you are running Windows 95 or 
Windows NT, use the 32-bit versions of the programs.    They take full advantage of the added 
multitasking capabilities of these operating systems. 

Installing the Registered Version
Installing the registered version of PC-TimeClock is even easier.    To begin, insert the diskette 

into your drive, select File|Run from the program manager, and type a:install (or b:install if you
are using drive B).

You will be asked if you wish to install the package; click the Install button.

You will then be asked where you want PC-TimeClock to be installed.    Normally you should 
choose the same directory in which you put the shareware version: the registered version of the software 
replaces the shareware version without disturbing any data you have already created.    The default 
directory is c:\timeclk; if this is acceptable, click the OK button.    If you want to put it somewhere else, 
type the desired directory name before clicking OK

The programs and files are then created in your chosen directory.    When this is completed, you 
will be asked whether you want program items created.    Clicking the Yes button causes a new group to 
be created in the Program Manager or Start Menu, with program items for PC-TimeClock and PC-
TimeClock Reporter.    Clicking No skips this step.

The registered version of the package comes with both 16-bit and 32-bit versions of the 
programs.    The 16-bit programs are called timeclk.exe and tcreport.exe, and the 32-bit programs 
are called timclk32.exe and tcrept32.exe.    The version you should use depends on which version 
of Windows you are running:

Windows 3.x: 16-bit
Windows 95 and Windows NT: 32-bit

The 32-bit version will take full advantage of the multitasking capabilities of Windows 95 and 
Windows NT.



Installing ctl3dv2.dll or ctl3d32.dll
The file ctl3dv2.dll provides a 3-dimensional look to the screens used by the 16-bit versions 

of both PC-TimeClock and PC-TimeClock Reporter.    The file ctl3d32.dll does the same (to a lesser 
extent) for the 32-bit versions of the programs when run under Windows NT versions prior to 4.0.    To 
enable this effect, the correct file must exist in either your \windows\system or \winnt35\system32 
directory.

First check these directories to see if you already have the correct file on your system.    If you do 
and it is either the same or a later version than the file we've provided, it is already installed; you may 
delete the unneeded copies that came with PC-TimeClock.

If ctl3dv2.dll (or ctl3d32.dll, as appropriate) appears in your \windows\system (or \
winnt35\system32) directory but it is an earlier version, then use the File Manager or the Explorer to 
replace your existing file with this one.    If Windows complains that the file is in use when you try this, try 
exiting Windows and moving the file from DOS.

If ctl3dv2.dll (or ctl3d32.dll)is not in your \windows\system (or \winnt35\system32)
directory, then use the File Manager or Explorer to move it to the appropriate directory.

Starting PC-TimeClock Automatically
It is most convenient to run PC-TimeClock automatically whenever Windows starts.    To do this in

Windows 3.x and NT 3.51 and earlier, go to the Program Manager and open the PC-TimeClock group.    
Move the mouse pointer over the PC-TimeClock icon.    Now, press the left mouse button; while holding it 
down, drag the icon so that it is over the StartUp group, then release the left mouse button.

If you now open the StartUp group, you should see the PC-TimeClock icon in it.    From now on, 
PC-TimeClock will be run automatically every time Windows is started.

The procedure for doing this in Windows 95 and Windows NT 4.0 and later is a little longer:

1) Click the Start button, and point to the Settings entry.

2) Click the taskbar entry, and select Start Menu Programs.

3) Click the Add button, then click the Browse button.

4) Locate PC-TimeClock and double-click it.

5) Click the Next button, then double-click on the StartUp folder.

6) Finally, type PC-TimeClock for the program name and click the Finish button.

Uninstalling PC-TimeClock
The installation procedure for PC-TimeClock does not create any files in any directories other 

than the one you specified as the installation directory.    This makes it easy to uninstall PC-TimeClock if 
you need to.    Here's how:

1) Delete the directory in which you installed PC-TimeClock.

2) Use the Program Manager to delete the PC-TimeClock group if you created one.

3) If you put PC-TimeClock in the StartUp group, remove it.

4) If you moved ctl3dv2.dll into your \windows\system directory because your system did 
not have one already, delete it.    If you replaced an older version of ctl3dv2.dll with the one that came
with PC-TimeClock, there is no need to restore the original version, as other programs that used the 
earlier version will also work with the later one.



Tutorial
Getting Started

This tutorial will take you step by step through all of the functions and features of PC-TimeClock 
and PC-TimeClock Reporter.    It is expected that most people using the tutorial will be working with the 
shareware version of the package, however everything that is described (except for the shareware 
reminder screens) also applies to the registered version.

The tutorial consists of several lessons.    We recommend that you do the lessons in order to get 
the most out of them.    Actions that you are supposed to perform are shown in red to make them hard to 
miss.

Click the >> button now to begin!



Lesson 1
Creating and Modifying Categories and Projects

The first lesson begins on the assumption that you have already unpacked the shareware version
of the program and installed it in some directory.    After all, you wouldn't be reading this help file if you 
hadn't.

Start timeclk.exe, which is the PC-TimeClock program.    

There are several ways of doing this; here are two:

1) Select File|Run from the Program Manager and type the complete pathname to PC-TimeClock.    
For example, if you copied the programs into the directory c:\timeclk, the complete pathname 
would be c:\timeclk\timeclk.exe.    Windows 95 and Windows NT users should use c:\
timclk\timclk32.exe instead.

2) Open the File Manager and display the directory containing PC-TimeClock.    Then double-click 
the timeclk.exe (or timclk32.exe) entry.

You will see the shareware reminder screen; read it and click the OK button to continue.

An empty PC-TimeClock window will now appear, and you will see a window that says that you 
have no projects, and asks if you would like to create some now.    Click the Yes button and the Change 
Categories and Projects window will appear.    We'll call this the Projects screen.

Categories are groups of projects that have something in common.    A typical use of PC-
TimeClock is to gather data on the business use of a computer in order to justify a tax deduction for 
depreciation.    To do this, you will need at least two categories: one for business use, and another for 
non-business use.

Let's call the first category Business.    Click the New button in the Categories box of this 
window.    The New Category window appears.    Type Business into the box labeled Category Name 
and click the OK button. 

The new category now appears at the top of the PC-TimeClock window, and also in the 
Categories box of the Projects screen.    When you modify categories or projects with this screen, you will 
see the results immediately in the PC-TimeClock window.

Add another category called Pleasure the same way.    The PC-TimeClock window is now split 
in two, with Business on one side and Pleasure on the other.    The projects you add to each category will 
be shown in the corresponding columns in this window.

Changing a category is just as easy.    Let's change Pleasure to Personal.    Click the Edit 
button and a window appears that contains the old category name.    Simply type in the new name and 
click OK.    The change appears immediately in both windows.

Let's add some projects now.    This should be easy, as it is very similar to adding categories.    
The only difference is that you must select the right category before you add the project.    Let's add two 
projects to the Business category; we'll call them Consulting and Reviewing.    First, select the 
Business category by clicking the arrow at the right of the Categories box.    A list of all your categories 
appears: select Business by clicking it with the mouse.    Any projects you add now will be put in this 
category.

Add the Consulting and Reviewing projects by clicking the New button in the Projects area of 
the window, entering the project names, and clicking the OK button.    As you add each project, it appears 
in the PC-TimeClock window and also in the Projects box of the Projects screen.    The order in which 
they appear is the order in which you enter them.

Now select the Personal category.    Notice that the Projects box on the Projects screen goes 



blank: that is because there are no projects in this category yet.    When you select a category, the 
Projects box always changes to show the projects in that category.

Add two projects to the Personal category like you did before; call them Games and Taxes.      If 
you make a mistake, you can edit project names the same as category names.

Now click the OK button at the bottom of the Projects screen.    This makes your changes 
permanent.    Until you do this, the changes are only temporary, and clicking the Cancel button will 
discard them.

At this point you know enough to proceed to the next lesson if you wish.    The remainder of this 
lesson covers the remaining functions of the Projects screen, which are not needed for the rest of the 
tutorial, so you can return and do them later if you are anxious to get going.

Let's return to the Projects screen: click the Projects menu from the menu bar and select the 
Change Projects item: the Projects screen reappears.    You can also get to this screen by pressing the F2
key.

Click the Delete button in the Projects box of this screen and watch what happens: the current 
project is deleted in both windows.    Now click the Delete button in the Categories box of the screen and
the entire category, with all of its remaining projects, goes away.    This is how you delete projects and 
categories.

We don't really want to delete these, so click the Cancel button and watch what happens: 
everything reappears!    This is because the changes you make are not permanent until you click the OK 
button.

There are a few more things you can do with the Projects screen, so press F2 to start it again.    
Now click the Color button, and you will see a color selection window.    Here you can select the color 
that PC-TimeClock will use to show this category and its projects.    You can select from the Basic Colors 
shown at the left, or make your own color using the controls at the right.

This screen is capable of showing more colors than many computer displays can, so look at the 
box labeled Solid to see what the color will look like on your display.    When you have a color you like, 
click the OK button in the color screen.    If you decide you don't like the color after all, you can click Color
to change it again, or click Cancel to discard your changes.

The Up and Down buttons in the Categories box allow you to move the category you have 
selected up or down in the list of categories; this moves it to the left and right respectively in the PC-
TimeClock window.    The Sort Categories button arranges all of your categories in alphabetic order by 
name.

The Projects box has a similar set of buttons that allow you to change the order of projects.    To 
use them, you must first select the category you wish to change in the Categories box above.    Play with 
all of these buttons until you become comfortable with their use, and remember that clicking Cancel 
always throws away any changes youve moade.

We're done playing with the Projects screen, so click OK to close it, and click >> above to proceed
to the next lesson.



Lesson 2
Checking In and Out

Now that you've entered some projects, you can see what PC-TimeClock really does.    The idea 
is to check in to a project when you begin working on it, and check out when you are finished.    PC-
TimeClock saves the times when these events occur, and PC-TimeClock Reporter reads the resulting log 
file in order to summarize the results.

Checking in is simple: just point to the project name with the mouse and click the left mouse 
button.    Let's suppose you are about to begin some consulting work.    Move the mouse pointer to the 
Consulting project in the PC-TimeClock window left-click it.      The project name is highlighted in reverse 
video, and a timer begins to show the time used so far on this project.

Note: if the project name disappears, your computer's display system may have a problem with 
reverse video.    To disable it, select the Change options item on the Options menu, click the checkbox 
labeled Highlight current project, and then click OK.    This should eliminate the problem.

This timer may skip a second every now and then; this is caused by the inherent inaccuracy of 
the timer.    It is nothing to worry about, though, as PC-TimeClock always records your check in and check
out times to the nearest second.

When you are done with the project, you check out by clicking the right mouse button.    It doesn't 
matter where the pointer is, as long as it is somewhere in the PC-TimeClock window.    Check out now by 
right-clicking the mouse anywhere in the PC-TimeClock window.    The time display disappears, but the 
time that you checked in and out is saved in the log file for later reporting.

Now check in to another project, say Games.    Wait a few seconds, and then without checking out
first, check in to the Taxes project.    Note that checking in to a project automatically checks you out of 
your previous project.

You can store a memo in the log file when you check in if you wish; this memo can be used in any
way you wish, for example to give some details as to the nature of the work you're doing.    To enter a 
memo, press and hold the Shift key down while you check in to the project.    Do that now: hold the Shift 
key down and left click the Reviewing project: a window appears asking for your memo.    Enter any text 
you wish and click the OK button.    If you decide you don't want a memo after all, you can click Cancel 
instead.    The memos are saved in the log file and appear on the activity report.

It is inevitable: sooner or later you will start working on another project and forget to check in to it. 
This situation is easily remedied by adjusting the check out time.    Let a couple of minutes build up on the 
current project, and then press and hold the Ctrl key down while you check in to any other project.    A 
window appears asking how long ago you want to check out; enter one minute and click the OK button.

The project you just checked in on shows one minute of time already; this is because the time 
adjustment affects both the check out time for the previous project and the check in time for the new one.  
If you hold the Ctrl key while you check out of a project by right clicking the mouse, only the check out 
time is adjusted.

Let a couple of minutes of time build up on the current project, and then press and hold the Ctrl 
key down while you check in to any other project.      This time, enter 500 minutes and click the OK button.  
Note that the time adjustment does not let you move the check out time so far back that it is before the 
check in time for the project.

We're done with this lesson, so check out of the current project, and click the >> button above to 
continue.



Lesson 3
PC-TimeClock Reporter

You've checked in and out of several projects by now, so let's see what kind of information you 
can get from PC-TimeClock Reporter.

Start tcreport.exe, which is the reporter program.    Windows 95 and Windows NT users 
should start tcrept32.exe instead.    You may use the Program Manager, the Start menu, the File 
Manager, Explorer, or any other technique to do this.    You will see the shareware reminder screen; read it
and click the OK button.

To begin with, just click the Create Report button. This produces a summary report and 
displays it using Notepad.    If you get an error message complaining that there is a check in entry with no 
matching check out entry, it is because you are still checked in on a project with PC-TimeClock.    Close 
both Notepad windows, check out of that project, and create a new report.

The summary report has two sections: the first shows a summary of usage for each project that 
you spent time on.    This is done category by category, and includes a total for each category.

For each project, the report shows the hours spent, the percentage of your total use that this 
project had, the percentage of your use in this category that this project had, the number of sessions and 
average duration of each session, and the project name.

The second section shows the category totals.    For each category, the report shows the hours 
spent, the percentage of your total use that this category had, the number of sessions and average 
duration of each session, and the category name.

Close Notepad, click the Activity button in PC-TimeClock Reporter, and then click Create 
Report once again.    This produces an activity report, which shows the details of your usage.    Each line 
in this report shows the date and time of a check in, followed by the duration of the session, and the 
project and category names.    If a memo was entered, it appears last.

Close Notepad again.  

The PC-TimeClock Reporter window has several controls to allow you to select subsets of data to
report on.    They wont do much yet because your log file doesn't contain very much data, but here is a 
brief description of them.

Click on the arrow at the right end of the Dates box.    This shows you the pre-defined intervals 
that you can choose; if you select one, only the entries whose check in time falls within the interval are 
processed for the report.

If none of these intervals fits your needs, you can enter any dates you wish in the From and To 
boxes.    By default, dates are entered in mm/dd/yyyy format, though you can change this with the Date 
Format entry on the Options menu.    You can enter the year as a two digit number; values less than 80 
are assumed to be 2000 - 2079, and values greater than or equal to 80 are assumed to be 1980 - 1999.

The Category box allows you to restrict the report to one category if you wish.    The Project box 
allows you to restrict the report to one project; if the project name chosen appears in more than one 
category, they will all be shown unless the categories are restricted too.

You've seen the Summary and Activity buttons, which change the format of the report.    The 
Log File button allows you to select a specific log file if you have more than one, and the Report 
File button lets you specify the name of the file that the report is created in.

You've already used the Create Report button; the Done button exits PC-TimeClock 
Reporter.

The menu bar at the top provides another way to specify the log file name and report file name, 
and to exit the program.    The Options menu allows you to select the format you prefer for dates and 



which text editor will be used to display the report, and the Help menu gives you access to the on-line 
help.

That's the end of this lesson, so click the Done button to exit PC-TimeClock Reporter and then 
click the >> button above to begin the last lesson. 



Lesson 4
PC-TimeClock Options

There is very little left to learn!    The PC-TimeClock Options screen allows you to customize the 
manner in which PC-TimeClock displays information. To begin, start PC-TimeClock if it is not already 
running.

Before you bring up the Options screen, check in to a project, wait a minute or so, check in to a 
different project, want another minute, and then check in to the original project again.    This will generate 
enough data to make the various options easier to see.

Now either select the Change options item under the Options menu, or press F3 to bring up the 
Options screen.    

The first two boxes allow you to specify any names you wish for the log file and the project file.    
The former is where the check in/check out information is stored, and the latter is where your project and 
category names are stored.    These boxes can be useful if you keep more than one of either of these 
files.

Let's look at the Current Project Time buttons do.    Click the Total time button.    The 
time shown for the current project is now the total time that you have spent on that project since PC-
TimeClock began.    Click the Since last check-in button and the display shows only the time since 
you last checked in on the project.    This only affects how the data is displayed, not how it is stored, so 
you can select whichever you prefer.

Now click the All projects button in the Display Time For box.    The total time used on 
all the other projects is now shown.

The Close window after check-in checkbox causes PC-TimeClock to minimize itself 
automatically when you check in.    This gets it out of the way of other windows on your screen; also, PC-
TimeClock consumes slightly less system resources when it is minimized.    Click this checkbox, then click
OK, and then check in to a new project.    PC-TimeClock is now minimized.    Double click its icon to 
restore it, and bring up the Options screen again.

If the Ask for memo on check-in checkbox is checked, PC-TimeClock will ask you for a 
memo every time you check in.    If you decide you don't want a memo for a check in, simply click the 
Cancel button on the memo screen.

The Show menu bar checkbox controls whether the menu bar is displayed.    The menu bar is 
not absolutely necessary, as all of its functions can be accessed in other ways.    Click this a few times 
and watch the PC-TimeClock window; leave it in whichever style you prefer.

If you want it to, PC-TimeClock will periodically ask you whether you are still working on the 
current project.    This is an annoyance, but makes it less likely that you'll forget to check in when you 
change projects.    Set the Minutes between confirmations box to 1, and then click the OK button. 
Now check in to any other project.    In approximately one minute, a window opens asking whether you 
are still working on the project you checked in to.    If you are, click the Yes button.    Otherwise, click the 
No button and PC-TimeClock will be restored so you can check out.    If you actually changed projects a 
while ago, hold the Ctrl key down while you check in to the new project so you can adjust the check 
in/check out time.

Bring up the Options screen again and set the Minutes between confirmations to zero to 
disable it for now.    Later, you can set this to whatever value you wish.

Click the Change Background Color button and the color selection dialog appears.    This is 
the same window you used to select the color for your categories, only now you are choosing the 
background color in the PC-TimeClock window.    By default, the background is light gray, but you can 
choose any color you wish. The dividing lines in the window are drawn in a complementary color.    Try 
selecting various colors and clicking the OK button to see what happens.



The background color and the colors you have chosen for your categories are interdependent; for
example, if you choose black for both, you won't be able to read the text.    Play with the colors until you 
find a combination that looks pleasing.

Finally, the changes you make with this screen are not permanent until you click the OK button.    If
you don't like what you've done, simply click Cancel and the changes are discarded.

And that's it!    You know enough about PC-TimeClock now to use it effectively.    Try it out for the 
full 60 day evaluation period.    If it suits your needs, please register the program.    The shareware 
concept depends on users like you: registering programs that you use encourages shareware authors to 
create more software for you!



Using PC-TimeClock
PC-TimeClock keeps track of the time you have spent on one or more projects, and allows you to

group these projects into one or more categories.    Some examples of projects might include taxes, 
games and entertainment, word processing, and system maintenance.    These can be grouped into 
categories such as business and pleasure; you may also wish to create a category for each client.

When you begin working on a project, you check in, and when you finish with that project, you 
check out.    Checking in to a new project automatically checks you out of the previous project.    PC-
TimeClock records these events in a log file, which can then be listed or summarized with PC-TimeClock 
Reporter.



Using PC-TimeClock
Creating Projects and Categories

Projects and categories are created, deleted and modified with the Projects screen, which can be 
started either by pressing F2 or by selecting the Projects entry from the menu bar.    You may not be 
checked in to a project when you do this.

The screen has three components: a Categories section, a Projects section, and the OK, Cancel,
and Help buttons.    As you work, the changes you make are shown in the PC-TimeClock window.    When
you have made the desired changes, click the OK button to make your changes permanent.    Clicking the 
Cancel button discards any changes you made since starting the screen.

The Categories section shows your categories.    To select a specific one, click the arrow at the 
right of the category box and select the desired category from the list.    The Projects section always 
shows the projects defined for the current category.    Specific projects are selected in the same manner 
as with categories.

Adding a Category
To add a new category, click the New button in the Categories section.    Enter the name of the 

new category in the space provided, and click OK.    The new category will be added to the end of the 
category list.

The new category name must be different than all existing ones.    Also, category names may 
contain letters, digits, spaces (but not tabs), and any punctuation marks except for the colon. Category 
names may not be empty.

Up to ten different categories may be specified.    However, the more categories you have, the 
narrower the columns in which PC-TimeClock displays the project names.

Changing a Category Name
To change the name of a category, first select it from the Categories list, and then click the Edit 

button.    Make whatever changes you wish and then click the OK button.    The new category name 



replaces the old one in the same position in the Categories list.

Deleting a Category
To delete a category, first select it from the Categories list, and then click the Delete button in 

the Categories section.    The category and all of its projects are removed.    If you accidentally delete the 
wrong category, clicking the Cancel button will bring it back.

Setting the Color for a Category
By default, category and project names appear in black in the PC-TimeClock window.    However, 

you can specify a different color for every category if you wish.    To change the color used to write a 
category and its projects in the PC-TimeClock window, first select the category from the Categories list, 
and then click the Color button.    Choose the desired color either from the selection of Basic Colors or 
from the palette at the right.

The range of colors you may select depends on the display hardware on your computer.    The 
color selection screen may therefore show you more colors than your computer can actually display.    
However, the box labeled Solid always shows the color that will appear on your screen.

The background color of the PC-TimeClock window may be changed via the Options screen.

Adding a Project
To add a new project, you must first select the category to which the project will belong.    Then 

click the New button in the Projects section, enter the project name in the space provided, and click OK.    
The new project will be added to the end of the project list for this category.

The new project name must be different than the names of projects already in this category, 
however it is permitted for a project in one category to have the same name as a project in another 
category.    Also, project names may contain letters,    digits, spaces (but not tabs), and any punctuation 
characters except for the dash.    Project names not start with a pound sign (#), and may not be empty.

Each category may contain up to 25 projects.

Changing a Project Name
To change a project name, first select the category to which it belongs, then select the project you

wish to change.    Categories and projects are both selected by clicking on the arrow at the right of their 
respective boxes and selecting an entry with the mouse from the list.    Click the Edit button, make 
whatever changes you wish, and click the OK button.    The new project name replaces the old one in the 
same position in the Projects list.

Deleting a Project
To delete a project, first select the category to which it belongs, then select the project you wish to

change and click the Delete button in the Projects section.    If you accidentally delete the wrong project 
or delete the category instead, clicking the Cancel button will bring it back.



Using PC-TimeClock
Checking In and Out

PC-TimeClock displays your projects on the screen with a separate column for each category you
have defined.    The categories and projects are shown in the order in which they were entered, unless 
you have changed their order using the Projects screen.

When you begin working on a project, find the name of that project on the PC-TimeClock screen.  
Move the mouse pointer over the name and click the left mouse button.    This checks you in to the 
project, and writes an entry to the log file noting the date, time, and project you chose.

The project name will be highlighted and added to PC-TimeClock's title bar to make it easy to see
your current project.    When you check in, PC-TimeClock also starts a clock which shows the 
approximate time you have spent on the project so far this session.

To check out of a project, click the right mouse button.    It does not matter where the mouse 
pointer is so long as it is somewhere in the PC-TimeClock window.    If you are going to begin another 
project right away, you may simply check in to it; PC-TimeClock will automatically check you out of the 
previous project.

If you terminate PC-TimeClock while you are still checked in to a project, it will automatically 
check you out.    The same is true when Windows exits.    If your system crashes, however, the log file 
may be left with a check-in entry which has no corresponding check-out entry.    This problem is taken 
care of by the CrashGuard feature the next time you start PC-TimeClock.

Adding a Memo
If you wish, you may enter a memo when you check in describing the work you are about to 

begin; you may enter any message, up to 125 characters long.    PC-TimeClock records the memo in the 
log file, and PC-TimeClock Reporter prints them in the activity report.

To enter a memo, hold the Shift key down while you check in to your project.    A box will appear 
asking you to enter your memo; type the desired memo and then either press Return or click the OK 
button.    If you make a typing mistake, you may correct it either by backspacing or using the mouse or 
arrow keys.    If you click the Cancel button, no memo will be recorded.

If you find that you are entering memos more often than not, you may have PC-TimeClock ask 
you for a memo every time you check in to a project.    This is accomplished with the Options screen.    If, 
after doing this, you want to check in to a project without entering a memo, simply click the Cancel 
button.

Altering the Time



Forgetting to check out of a project when you begin work on a different one causes the reports to 
be inaccurate.    PC-TimeClock provides a way to fix the log file if this should occur.

Holding the Ctrl key down while you click the left mouse button to check in to your next project 
causes a screen to be shown asking you how many minutes ago you should have checked in.    Enter the 
desired number of minutes and click OK.    The check out time for the old project and the check in time for 
the new project will both be adjusted by this number of minutes.

The adjustment may not be larger than the time you've been checked in on the project.    If it is, 
the adjustment is set equal to the check in time for the old project.

Holding the Ctrl key down while you click the right mouse button does the same thing, but the 
adjustment only affects the check out time, not the next check in time.



Using PC-TimeClock
CrashGuard

If your computer crashes when you are checked in on a project, PC-TimeClock won't be able to 
write the corresponding check out entry.    This error in the log file makes it impossible for PC-TimeClock 
Reporter to correctly report the time for the session.

PC-TimeClock CrashGuard is a feature that detects and corrects log file errors of this type.    
When you start PC-TimeClock, CrashGuard examines the last entry in the log file.    If it is a check in 
entry, CrashGuard shows you the project, category, and the time you checked in. You have two choices 
for correcting the problem: continuing to work on the project, or checking out at a time of your choosing.

Continuing a Project After a Crash
If your computer crashes and you restart it right away and continue working on the same project, 

then click the Continue button.    This causes PC-TimeClock to continue with the same project as if the 
crash had not occurred.    The check out entry corresponding to the last entry in the file will be written 
normally when you next check in to another project.

Checking Out of a Project After a Crash
If your computer crashes and you don't restart it until later, or you restart it but start working on 

another project, then you want to check out of the old project.    To do this, enter the date and time when 
you stopped working on the old project (usually this will be the time of the crash) in the appropriate boxes 
of the screen, and click Check Out.    A check out entry is written with this date and time for the old 
project, thus making the log file complete.

The date is entered year first, then month, then day, so March 6, 1996 would be entered as 
1996/3/6.    The time is entered in hour:minute:second fashion, using military time.    It is not necessary 
to use leading zeros for single digit numbers.    For example, 4:05 PM would be entered as 16:5:0.





Using PC-TimeClock
Changing Options

There are numerous options you may select to customize PC-TimeClock to your liking.    The 
Options screen is used for this purpose; it is accessed either by pressing the F3 key or by selecting the 
Options item on the menu bar.

The screen has several sections, and three buttons at the bottom: OK, Cancel, and Help.    
Changes made on the options screen will be immediately visible in the PC-TimeClock window.    Click the 
OK button to make the changes permanent; clicking the Cancel button discards any options changes you
have made since the screen was called up.

Log File Name
This box specifies the name of the log file.    By default, this is timeclk.log.    If you prefer to 

use a different name for the log file, enter it here.

In order to avoid corrupting the log file, this name may not be changed if you are currently 
checked in to a project.

Project File Name
This box specifies the name of the file containing the projects and categories; the default name is 

project.txt.    If you prefer to use a different name for this file, enter it here.

Current Project Time Display



This box determines how the time for the current project is displayed.    By default, only the time 
since the most recent check in is shown.    By clicking Total time, the total time spent on the project since 
the last time PC-TimeClock was started in shown instead.

Note that this has no effect on how the time is recorded in the log file; only the PC-TimeClock 
display is affected.

Time Display for Other Projects
This box determines whether to display the time used for projects other than the current project.    

By default, PC-TimeClock only shows the time for the current project.    If you click All projects, the time for
every project that has been used since the last time PC-TimeClock was started will be shown.

Note that this has no effect on how the time is recorded in the log file; only the PC-TimeClock 
display is affected.

Minimizing PC-TimeClock Automatically
Once you have checked in to a project, you don't need PC-TimeClock again until you want to 

check out.    Checking this check box causes PC-TimeClock to minimize itself automatically every time 
you check in to a project.    When it is minimized, PC-TimeClock is more efficient because it makes less of
a demand on system resources.

Un-checking the box leaves PC-TimeClock open after checking in, which can be helpful in 
observing the effects of changing other options.

Highlighting the Current Project
If this box is checked, the current projectwill be highlighted with reverse video when you check in 

to it.    This makes it easier to spot, especially if you have elected to display the time for all projects.

However, some video adapters have trouble with reverse video.    If your computer doesn't 
properly highlight the current project, or if you prefer not to use highlighting, un-check this box to turn it 
off.

Asking for a Memo on Each Check In
Pressing the Shift key when checking in causes PC-TimeClock to ask you to enter a memo 

describing the work you will be doing on the project.    If this box is checked, you will be asked for a memo
every time you check in.

If you don't want to enter a memo for a particular check in, press the Cancel button.

Displaying or Hiding the Menu Bar
Normally, the menu bar is displayed at the top of the PC-TimeClock window.    However, all of the 

functions that can be obtained with the menu bar can also be obtained without it using these shortcut 
keys:

F1 Help
F2 Project/Category screen
F3 Options screen

Un-checking this box causes the menu bar to disappear, so that PC-TimeClock takes less room 
on the screen.

Setting the Reminder Interval
You can arrange for PC-TimeClock to ask you periodically whether you are still working on the 

same project.    To do this, enter the desired interval (in minutes) between confirmations in the box 



provided.

At the end of each interval, PC-TimeClock will show you the current project and ask whether you 
are still working on it.    Click Yes if you are.    Clicking No opens the PC-TimeClock window so you can 
check out or check in to another project.

If you are already working on another project, use the Ctrl key to enter the time when you should 
have checked out.    See Altering the Time for details.

Specifying an interval of zero disables the periodic confirmations.

Changing the Background Color
This button allows you to change the background color of the PC-TimeClock window to suit your 

tastes.    The color selection screen is the same one used to specify the color for categories.



PC-TimeClock Reporter
PC-TimeClock Reporter reads the data in the log file and produces various reports from it.    The 

Windows interface makes it easy to specify exactly what information you want.

The report is written to a disk file, and then displayed with Notepad.    It may be printed using Notepad's 
printing capabilities.

If any errors were found in the log file, PC-TimeClock Reporter tells you the line number in the log
file where the problem occurred, the nature of the error, and the faulty entries.    You may choose to ignore
the errors and use the report as is, or you may repair the log file and create another report.

Note that if you are checked in to a project when you generate a report, an error will be reported 
on the last line of the log file.    This is because there is no check out entry yet for the current project.    You
may either ignore this error, or check out and create a new report.

If you have changed or deleted categories or projects, it is possible that the log file may contain 
projects or categories that no longer exist.    PC-TimeClock Reporter can therefore handle up to 20 
categories, with up to 50 projects in each category.

Using the Reporter
The PC-TimeClock Reporter screen contains a number of features that allow you to specify 

exactly what information to report, and the format in which to report it.

Dates
The first row    allows you to select the range of dates to report on.    The default is to include all 

entries from the log file, but you can also limit the report to a specific range of dates.

The following pre-defined ranges may be selected from the Dates list:
All entries
This year
This quarter
This month
Last year
Last quarter
Last month

When any of these except All entries is selected, the From and To fields show the actual dates that 
will be used.    In addition, you may enter any dates you wish in the From and To fields.

Category



The Category window selects which categories to include on the report.    The default is All, but 
by clicking on the arrow button at the right of the window you can obtain a list of all category names.    
Selecting a name from this list limits the report to only the projects in that category.

Project
The Project window specifies which projects should be included in the report; it works the same 

as the Category window.    If a project is selected which appears in more than one category, they will all 
appear on the report unless a specific category is also chosen.

Summary, Activity
The Summary button causes a summary report to be produced, and the Activity button causes an

activity report. to be produced.

Log File
The Log File button allows you to select a log file to report.    The name of the log file being used 

is shown in the title bar at the top of the window.    When PC-TimeClock Reporter starts, it looks in the 
directory from which it was started for files with the .log extension.    If only one is found, that file is 
opened.    Otherwise, you are asked to choose which file you want to use.    This button allows you to 
select a different log file at any time.

Report File
The Report File button allows you to change the name of the file in which the report is written.    

The name of the report file being used is shown to the right of the Activity button.    By default, the name 
report.txt is used.    If several reports are created one after another, each will replace the previous 
report in this file; unless each one is printed before the next is created, all but the last one will be lost.    
This button allows you to give each report a different name so that they will not replace one another.

Create Report
The Create Report button creates a report.    When you have specified which entries you want, 

click this button.    The cursor changes to an hourglass while the data is being processed.    When the 
report is complete, it will be displayed using Notepad.    If any errors were found in the log file, descriptions
of them will be written to an error file, which is also displayed with Notepad.    The name of the error file is 
the same as the name of the report file, except has a .err rather than a .txt extension.

Done
Click the Done button when you are finished; it causes PC-TimeClock Reporter to exit.

Menu Bar
The menu bar at the top of the window contains three menus.    The File menu allows you to 

select a log file to process, and to choose the name of the file that the report is written to.    It also lets you 
exit the program.

The Options menu allows you to select the date format you prefer; you can choose among 
mm/dd/yyyy, dd/mm/yyyy, and yyyy/mm/dd formats.    You can also select which editor you want to 
display the report and any errors that occur; the default is Notepad.    To use a different editor, select this 
menu entry and enter the full pathname to the editor of your choice.    If PC-TimeClock Reporter cannot 
execute the editor, it will tell you in a message box when you attempt to create a report.    If this happens, 
select a different editor and create the report again.

The Help menu allows you to access the help file.



Summary Report Format
This report summarizes your usage by project and category.    Here is a sample summary report:

File: c:\timeclk\timeclk.log
Summarizing all entries.

================= Summary of Usage By Project ================

           % of   % of   -- Sessions --   Projects in category
   Hours  total  ctgry   # of  avg hrs/   "Business"
   -----  -----  -----   ----  --------   --------------------
     3.4    2.5    2.9      4   0:51:30   Taxes
    66.1   47.9   54.9     23   2:52:24   Acme Industries
    50.9   36.9   42.3     30   1:41:45   Marketview Realtors
   120.4   87.3  100.0     57   2:06:44   *** Total ***

           % of   % of   -- Sessions --   Projects in category
   Hours  total  ctgry   # of  avg hrs/   "Personal"
   -----  -----  -----   ----  --------   --------------------
     6.7    4.9   38.3     19   0:21:15   Games
     9.4    6.8   53.6     15   0:37:39   School work
     1.4    1.0    8.1      7   0:12:11   Taxes
    17.6   12.7  100.0     41   0:25:42   *** Total ***

============ Summary of Usage By Category =============

           % of   -- Sessions --
   Hours  total   # of  avg hrs/   Category
   -----  -----   ----  --------   --------------------
   120.4   87.3     57   2:06:44   Business
    17.6   12.7     41   0:25:42   Personal
   138.0  100.0     98   1:24:28   *** Total ***
The report contains two sections.    The first summarizes usage by project.    A list is printed for each 
category showing the projects in that category that had any usage.    The following values are shown for 
each project:

total hours (and tenths) spent on the project
the percentage of the total use that this project represents
the percentage of the use in this category that this project represents
the number of sessions for the project
the average duration of each session (hours, minutes, seconds)
the project name

At the end of each category's project list is a line showing the totals for that category.

The second section of the report contains a summary of usage by category.    For each category 
that had any use, the following values are shown:

total hours (and tenths) spent on projects in this category
the percentage of the total use that this category represents
the number of sessions for projects in this category
the average duration of each session (hours, minutes, seconds)
the category name

Activity Report Format



The activity report lists each session whose date, project and category match the specified 
reporting criteria.    Here is a sample activity report:
File: c:\timeclk\timeclk.log
Activity for all entries from 1/1/96 to 1/1/96.

   Date      Time   Hours Project, Category, and Memo
---------- -------- ----- -----------------------------------
01/01/1996 08:25:36   2.0 Taxes-Business   figure gross sales
01/01/1996 10:27:13   0.5 Acme Industries-Business
01/01/1996 10:58:01   1.0 Taxes-Business   record receipts
01/01/1996 11:57:45   0.2 Games-Personal
The following values are shown:

the date and time when the session began
the length of the session in hours (and tenths)
the project and category names
the memo entered when checking in (if any)

Accuracy and Rounding of Times
PC-TimeClock records the time of each check in and check out to the second, and PC-TimeClock

Reporter processes them with full precision.    However, some time values are rounded to the nearest 
tenth of an hour for printing, which can result in what seems to be errors in summary reports.

To illustrate, consider the following activity report:
06/19/1994 11:32:22   1.2 Taxes-Business
09/01/1994 20:16:51   1.2 Taxes-Business
09/05/1994 17:57:51   1.2 Taxes-Business
It seems clear that a summary report of these entries should show a total of 3.6 hours.    However,

any duration from one hour nine minutes to one hour 14 minutes would be rounded to 1.2 hours in the 
activity report.    If each of these sessions were in fact one hour 14 minutes, then the summary total would 
be 3.7 hours; if they were in fact one hour nine minutes, the summary total would be 3.5 hours.

Because they are computed before any rounding is done, the totals shown on the summary 
report are more accurate than the totals you obtain by adding the values on the activity report.



The Log File
PC-TimeClock writes its check in/check out data to the log file.    It is very important to never run 

more than one PC-TimeClock at a time on the same log file.    If this were done, the entries written by the 
two programs would be interspersed with each other in the log file, and PC-TimeClock Reporter would be 
unable to sort them out.    On computers connected to a network, make sure that PC-TimeClock on each 
computer writes to its own private log file.

You do not ordinarily need to examine the log file itself, as PC-TimeClock Reporter can 
summarize as well as list the individual entries in the file.    However, if you wish to import the log data into
another program such as a spreadsheet, you will need to know what the file contains.    Furthermore, you 
must know what the entries in this file are supposed to look like in order to repair any damage in the 
unlikely event that the file becomes corrupted.

Log File Format
The log file contains adjacent pairs of entries; the first entry in each pair is a check in entry, and 

the second is a check out entry.    The format of these entries is shown below.    The symbol » represents 
the tab character, which separates the fields in each entry.

date/time»in/out»project-category»memo
The first field gives the date and time of the event.    The date is recorded in yyyy/mm/dd format to

avoid any problems when the year 2000 is reached.    It is followed by one space and the time, which is in 
hh:mm:ss format.    Military time is used.

The second field is either the word IN or the word OUT, and identifies the type of entry.    The log 
file should begin with an IN entry, and all the remaining entries should alternate OUT, IN, OUT, etc.

The third field shows the project and category, separated by a dash.    This must be the same for 
each entry in an in/out pair.

The last field is the memo; it only appears on the IN entry, and only on entries for which a memo 
was entered.    The only memo that appears on OUT entries identify check out events generated by 
CrashGuard.

Repairing a Damaged Log File
If PC-TimeClock Reporter finds any errors in the log file, it prints an error message that gives the 

line number of the damaged entry and a brief description of the problem.    The error messages are 
described below.    The damaged entry is then printed to assist you in understanding the problem.

To repair a damaged log file, use a text editor such as Notepad.    Do not use a word processor 
such as Write or Word as the formatting information they save will damage the log file further.

Malformed entry
This describes an entry that is not in the proper format.    This is usually the result of an 

unsuccessful attempt to correct some other problem in a log file.    If you see dozens or hundreds of these 
errors, it is likely that the file that PC-TimeClock Reporter is processing isn't a log file at all, or is a file that 
was "repaired" with a word processor rather than a text editor.

Too many project categories
This indicates that there are more than 20 different categories in the log file, and PC-TimeClock 

Reporter cannot handle the excess ones.    Projects belonging to the excess categories will not be 
included on the report.

While PC-TimeClock is limited to at most ten categories, you can delete them, add new ones, and



change their names.    Over time, the log file may accumulate entries for far more than the ten categories 
you may have at any one time.    If there are more than 20 categories, this error will occur.    There are 
three ways to solve this problem:

1) Split the log file into two or more smaller ones at some convenient date, then produce a separate 
report from each file.    This is a good approach if you wanted different reports for the different time 
periods anyway.

2) Edit the log file and change the names of some of the categories so that they are the same.    This 
is the best way to fix problems caused by typos in the category names.    For example, if a category 
was initially entered as business and you later decided to change it to Business, it is really the 
same category.    Entries in the log file ending in -business should then be changed to read -
Business.

3) Split the log file into two or more smaller ones, each containing the entries from a few categories.   
This is a good solution if it is not important for the time spent in each category to be compared with 
the time spent in the others.

Too many projects for this category
PC-TimeClock Reporter can handle up to 50 projects in each category.    This message indicates 

that more than 50 projects were found in one category.    The excess projects will not appear on the 
report.

This is very similar to Too many project categories described above, and the same 
remedies apply.

Check-out entry with no prior check-in
A check out entry was not preceded by a check in entry.    The orphan check out entry is ignored.

The most likely cause for this unusual error is having two or more copies of PC-TimeClock writing
to the same log file.    If that is what occurred, the check in entry actually appears earlier in the log file, and
will probably also be flagged as an error.    The other possible cause for this error is a log file that was 
incorrectly edited.

There are three ways to fix this problem:

1) Move the orphaned entry to just after its corresponding check in entry in the log file.    This is the 
correct remedy if the check in entry already exists earlier in the file.

2) Delete the orphaned entry.    If you don't know when the work began or the project is not an 
important one, this is a good approach.

3) Add a new check in entry just ahead of the orphaned entry.    The simplest way of doing this is to 
copy the orphaned entry, change the OUT to IN, and then modify the time to a reasonable value.    
Note that the check in cannot logically have occurred earlier than the immediately preceding check 
out entry.

Check-in with no subsequent check-out
By far the most common error, this error indicates that you checked into a project but never 

checked out.

It is nearly always caused by running PC-TimeClock Reporter while PC-TimeClock is still 
checked in to a project.    If this is the case, the remedy is to check out of the current project in PC-
TimeClock and then create a new report.

The other cause for this error is the computer crashing, which prevents PC-TimeClock from 
writing a check out entry.    However, the next time PC-TimeClock is started, the CrashGuard feature 



detects this and corrects the error.    Consequently, the problem can only occur if your computer has 
crashed, and you restart it and create a report without first running PC-TimeClock.    If this is the case, the 
remedy is to run PC-TimeClock and let CrashGuard do its work.

Check-out occurred before check-in
This obviously cannot happen in real life.    If you see this in your log file, the computer's clock 

was probably reset between checking in and checking out of a project.    If the dates and times in the 
entries make it obvious what is wrong, then simply fix one entry or the other.    Otherwise, delete them.



The Project File
The project file is where the names of your projects and categories are stored.    PC-TimeClock 

creates and modifies this file when you use the Projects screen to create new projects or categories, to 
edit or delete them, or ot change their order.    This section describes the format of this file so that you can
fix it if it has become corrupted by some other program.

The project file contains comments, and two sections of information.    Lines that begin with a 
pound sign # and empty lines are comments, and are ignored.

The first section is a list of the category names you have entered.    If a color was selected for a 
category, it is shown after the category name, separated from it with a colon.

The second section contains a list of the projects in each category; there is one list per category.   
These lists contain the project names; each name is followed by a dash and the name of the category to 
which it belongs.

Changing the Order of Projects or Categories
PC-TimeClock displays the categories and projects in the order in which they appear in the 

project file.    Ordinarily, you would use the controls on the Projects screen to change their order.



Limitations in the Shareware Version
The Shareware concept is easily explained: try before you buy.    The shareware version of PC-

TimeClock is fully functional and contains all the features of the registered version so that you can fully 
evaluate whether this software will suit your needs. However, the shareware version differs from the 
registered version in two important ways:

60 Day Evaluation Period 

You may use the software for the purpose of evaluating it for a period of 60 days.    After this time, 
you must register the software if you wish to continue using it.    Consequently, the functionality of the 
shareware versions of the programs is limited to the evaluation period.

1) PC-TimeClock will continue to operate for 30 days after the evaluation period, after which time it 
will cease to function.

2) PC-TimeClock Reporter will not process log file entries dated prior to the start of the evaluation 
period or after its end.    It will also continue to operate for 30 days after the evaluation period, after 
which it will cease to function.

The registered version of the program has no such limitations.    Furthermore, the registered 
programs will read the log files and project files you created with the shareware version.

Shareware Reminder Screens
The shareware version has reminder (some call them nag) screens.    The purpose of these is to 

remind you that you are using an evaluation copy of the program.    The reminder screens also let you 
know how many days are left in your evaluation period.

The registered version of the program omits these reminders entirely.

How to Register PC-TimeClock
To register PC-TimeClock, simply follow the instructions found in the file register.txt that 

came with your shareware copy.    This file also contains the current fee schedule for the package.    You 
can also register through CompuServe.    Just GO SWREG and enter ID #10404.    This is particularly 
convenient for international users, as CompuServe takes care of the currency conversion.



Technical Support
Registered users are entitled to one year of free technical support.    To obtain help, contact us via

US mail:

KMR Consulting
3090 Griffin Road
Churchville, NY 14428-9512

by electronic mail at either:

kar@cs.rit.edu Internet
74034,1441 CompuServe

or you may call us at (716) 293-3241 from 9 AM to 9 PM Eastern Daylight Time, or fax us at (716) 293-
3278.

Shareware users with questions are also welcome to contact us.



current project
The project that you are currently checked in on.



shareware
A method of marketing software that allows you to try it before you buy it.    Shareware software is not 
free: if you continue to use the software after the evaluation period, you must register it by paying a 
modest license fee to the author.



version
In Windows 3.1, the File|Properties screen in the File Manager will tell you the version number of a 
file.    In    the Windows 95 Explorer, simply right-click the file to bring up the properties screen.



project
Something that you use your computer for.    Some examples of projects are word processing, financial, 
games, or consulting.



category
A collection of projects that are somehow similar.    Some examples of categories are business, pleasure, 
and so forth.    PC-TimeClock Reporter summarizes your usage by both project and by category.



check in
To inform PC-TimeClock that you have begun working on a project.    You check in by left clicking the 
name of the project in the PC-TimeClock window.



check out
To inform PC-TimeClock that you are no longer working on the current project.    You check out by either 
right clicking anywhere in the PC-TimeClock window, or by checking in to another project.



log file
The file in which the check in and check out events are stored.



project file
The file in which your project and category names are stored.



memo
A description or message that you may enter when you check in to a project.    To enter a memo, press 
and hold the Shift key when you check in to the project.    The Options screen allows you to instruct PC-
TimeClock to ask for a memo every time you check in.



military time
The military notation for time does not need an AM/PM indication.    It uses the numbers zero through 12 
for midnight through noon, and the numbers 13 through 23 for one PM through 11 PM.



Selecting a category to modify
Click this box to view a list of your current categories; click the category you wish to modify.    This is 
called the current category.



Add a new category
Click this button to add a new category.    A window will appear; type the name of the new category in the 
box it contains.    The new category is added after all your existing category names.    Category names 
may not contain tabs or colons, and must all be unique.



Edit category name
Click this button to change the name of the current category.    A window will appear; make the desired 
changes in the box it contains.    Category names may not contain tabs or colons, and must all be unique.



Delete category
Click this button to delete the current category.    All projects in the category will also be removed.



Change category color
Click this button to change the color used to display the current category.



Sort categories
Click this button to arrange the categories in alphabetic order by name.



Change a category's position
Use these buttons to rearrange the order of your categories.    The Up button moves the current category 
upward in the list; this moves it to the left in the PC-TimeClock window.    The Down button moves it down
in the list (to the right in the window).



Select a project to modify
This box is used to select a project to modify.    First, select the category that the desired project belongs 
to in the category box above.    Then, click this box to view a list of the projects in the current category; 
click the project you wish to modify.    This project becomes the current project.



Add a new project to the current category
Click this button to add a new project to the current category.    A window will appear; type the name of the
new project in the box it contains.    The new project is added after all your existing project names.    
Project names may not contain tabs or dashes, and all the project names within a category must be 
unique.



Edit project name
Click this button to change the name of the current project.    A window will appear; make the desired 
changes in the box it contains.    Project names may not contain tabs or dashes, and all the project names
within a category must be unique.



Delete project
Click this button to delete the current project.



Sort projects in the current category
Click this button to arrange the projects in the current category in alphabetic order by name.



Change a project's position
Use these buttons to rearrange the order of the projects in the current category.    The Up button moves 
the current project up in its category list, and the Down button moves it down.



OK
Clicking this button makes any changes you have made permanent, and closes the categories and 
projects window.



Cancel
Clicking this button closes the categories and projects window, but discards any changes you have made 
since the window appeared.



Help
Clicking this button brings up the on-line help for this window.



Title bar
The title bar of the PC-TimeClock window displays the name of the project that you are currently checked 
in on, if any.



Menu bar
The menu bar gives you easy access to the Categories and Projects screen to create and modify projects
and categories, to the Options screen in which you can select the options you prefer, and to the on-line 
help system.    The Options screen also allows you to choose whether or not to show the menu bar.



Category headings
This portion of the PC-TimeClock screen contains the category names you have entered.    Each category
name appears over its own list of projects.



Project lists
This portion of the PC-TimeClock screen shows the projects that belong to each category.    Click on one 
of the project names shown with the left mouse button to check in to that project.    Click with the right 
mouse button anywhere in this area to check out of a project when you are done working on it.



Information about the current project
This box tells you the project (and category) that you were checked into when your computer crashed, 
and the date and time that you checked in.



Date and Time of Check Out
If you choose to check out of the project you were in when the computer crashed, enter the date and time 
when you stopped working on the project (usually this will be the time of the crash) in the boxes in this 
part of the screen.    Then click the Check Out button.



Continue
Click this button if you want to continue working on the same project you were working on before the 
computer crashed.



Check Out
If you are not working on this project any longer, enter the date and time when you stopped working on it 
in the Date and Time of Check Out box and then click this button.



Log file name
Enter the name of the log file you wish to use in this box.    You can specify any drive and directory you 
wish.



Project file name
Enter the name of the project file you wish to use in this box.    You can specify any drive and directory you
wish.



Since last check in
Click this button if you prefer the PC-TimeClock screen to display only the time elapsed since you last 
checked in to a project.



Total time
Click this button if you prefer PC-TimeClock to show the total time that youve used on this project since 
you last started the program.



Current project onlyl
Click this button if you prefer that PC-TimeClock show only the elapsed time on the current project.



All projects
Click this button if you would rather have PC-TimeClock show the elapsed time for all of the projects you 
have worked on since starting the program.



Close window after check-in
Select this box if you want PC-TimeClock to minimize itself when you check in to a project.



Highlight current project
Select this box if you want PC-TimeClock to highlight the project you are checked into by showing it in 
reverse video.



Ask for memo on check in
Select this box if you want PC-TimeClock to ask you to enter a memo each time you check in to a new 
project.



Show menu bar
Select this option if you want the menu bar to be shown at the top of the PC-TimeClock window.    
Whether the menu bar is shown or not, you can access the Projects and Categories screen by pressing 
F2, and you can access the Options screen by pressing F3.



Minutes between confirmations
If you like, you can have PC-TimeClock periodically ask you whether you are still working on the same 
project as before.    To do this, enter in this box the number of minutes you would like between these 
reminders.



Use 3d effects
Select this option if you prefer that the Projects and Options dialogs use 3-D effects rather than the older 
Windows style dialogs.



Change Background Color
Click this button to select a new background color for PC-TimeClock.



OK
Click this button to enable all the changes you made on this screen.    The changes will go into effect 
immediately, except for the 3-D effects which do not take effect until the next time you start PC-
TimeClock.



Cancel
Click this button if you have made some mistake and you do not want it to take effect.



Help
Click this button to access the on-line help system for PC-TimeClock.



Dates
This box allows you to select common ranges of dates.    Click the arrow at the right of the box to view the 
list, and select the desired range with the mouse.    If none of the ranges suits your needs, you may enter 
your own range of dates in the From and To boxes to the right of this one.



From and To
If none of the ranges of dates in the Dates box suit your needs, you may enter any range of dates in 
these boxes.    Enter dates in the date format you have chosen from the Options menu; by default this is 
mm/dd/yyyy.    Years may be entered as two digits rather than four; values less than 80 are assumed to 
be 2000 - 2079, and values greater than equal to 80 are assumed to be 1980 - 1999.



Category
Use this box to select the category you would like to include on the report.    The --All-- entry (which is the 
default) puts all categories on the report; otherwise, just the selected category is included.    Click the 
arrow to the right of the box to view the list of categories, and make your selection with the mouse.



Project
Use this box to select the project you would like to include on the report.    The --All-- entry (which is the 
default) puts all projects on the report; otherwise, just the selected project is included.    Click the arrow to 
the right of the box to view the list of projects, and make your selection with the mouse.



Summary/Activity
These buttons control the type of report that is produced.    The summary report summarizes your total 
usage by project and category.    In contrast, the activity report shows the details of each session.



Report file
This gives the name of the file that the report will be written to.    To change this name, click the Report 
File button below.



Log File
Click this button to select a log file to report on.



Report File
Click this button to enter a different name for the report file.



Create Report
When you have selected a range of dates and the category and project you want to know about, click this 
button to create the report.    The report will then be displayed using Notepad (or whatever other editor 
you have chosen).



Done
Click this button when you are finished to terminate PC-TimeClock Reporter.



File, Options and Help menus
With the File menu, you can select the name for the log file to process, select the name for the file in 
which to create the report, and exit the program.    These functions are also available by clicking the Log 
File, Report File, and Done buttons, respectively.

The Options menu allows you to select the date format you prefer.    You can choose among 
mm/dd/yyyy, dd/mm/yyyy and yyyy/mm/dd formats.    You can also select the editor you want to use to 
display the report after it has been created.    This editor will also be used to display any errors that were 
found while creating the report.    The default editor is Notepad.

Finally, the Help menu accesses the on-line help file that you are reading now.




